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Getting Started with Macintosh OS X 
 

 
 
This help sheet is intended for the beginning user who has 
little or no Macintosh OS X experience.  You will learn how 
the desktop and icons work, and how to access the available 
software.  Although there may be different ways to 
accomplish any given task, this sheet only explains one. 
 
 

Logging Into a Macintosh OS X 
 
1. Enter your username in the Name: field. 
 
2. Enter your password in the Password: field and press 

the Log In button. 
 
If you do not want to have to enter your information into the 
login window every time you turn your Mac on: 
 
1. Click the Apple icon and select System Preferences. 

The Login window appears. 
 
2. Select the Login Window tab. 
 
3. Click the box next to Automatically log in so that a 

checkmark appears. 
 
4. Enter your username and password in the correct fields 

and press the Set button. 
 
 

Using the Mouse 
 
The mouse is the device used to tell the Macintosh what to 
do. Instead of typing a command from the keyboard, you 
move the mouse around on a flat surface, and the mouse’s 
track ball mechanism translates your hand movements onto 
the screen.  The pointer arrow moves around the Macintosh 
screen as you move the mouse. 
 
In some applications, moving the mouse moves an I-beam or 
a cross.  The mouse button is used to activate commands 
from drop-down menus, select files, move files, delete files 
and select applications. 
 
The mouse has a button on the top.  When pushed (clicked), 
it selects and activates icons. 
 

What Is an Icon? 
 
Icons are small pictures that represent files, applications, 
disks, and other things that you use on a Macintosh desktop. 
 
Icons are designed to be easy to distinguish.  For example, 
the icon for a floppy disk looks like a disk; the icon used to 
delete files looks like a trash can; the icon for a document 
looks like a sheet of paper; the icon for a directory looks like 
a folder; and the icon for an application displays a picture, 
usually the program’s logo.  Icons are activated, copied, 
moved and deleted with the mouse.  Examples of some of 
the icons you will encounter on a Mac are shown below. 
 

 
 
How Do I Select and Move Icons? 
 
Move the mouse until it is pointing directly on the icon you 
want to select (an application, a drive, a folder, a document, 
etc.).  Press the mouse button and release it quickly.  This is 
called “clicking.”  A selected item is darkly shaded 
(highlighted).  If you quickly click the item twice without 
moving the mouse, the icon is activated. This is known as 
“double-clicking;” it is used to display the contents of 
drives, open directories (folders) and documents, and to start 
running all Macintosh applications. 
 
Moving the mouse while keeping the button pressed after 
selecting an icon allows you to move an icon around on the 
desktop.  This action is known as “dragging” and is used for 
arranging files on the desktop, copying files, deleting files, 
and moving files from disk to disk. 
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How Do I Access Folders, Disks, Hard Drives and 
File Servers? 
 

 

Folders represent directories and 
subdirectories in the Macintosh 
operating system.  Double-clicking a 
folder icon reveals the files stored 
within that subdirectory. 
 

 

A disk icon appears whenever you 
have a formatted floppy disk in the 
disk drive.  Double-clicking a disk icon 
displays a directory of the files on the 
disk. You must save your work on a 
floppy disk when working in the labs; 
work saved to any other drive is lost 
when you log off. 
 

 

Double-clicking a drive’s icon displays 
all of the software and files stored 
there.  Do not save work onto hard 
drives since they are erased frequently. 
Use floppy disks instead. 
 

 

File servers are large, hard drives that 
can be accessed from individual Macs 
through a network.  Double-clicking a 
server icon accesses the software 
applications stored on the file server.   

 
How Do I Move Files? 
 
To move a file from one location to another (for example, 
from the hard drive to a floppy disk): 
 
1. Select the icon representing the file you want to relocate 

by clicking it with the mouse.  (Keep the mouse button 
pressed.) 

 
2. Drag the mouse until the mouse pointer and highlighted 

icon are directly over the icon for the location to which 
you are moving the file. 

 
3. When the destination icon is darkened/highlighted, 

release the mouse button.  The file is moved to that 
directory/drive. 

 
How Do I Copy Files? 
 
If you want to place a copy of a file somewhere while 
keeping the original file where it is, you must: 
 
1. Select the icon representing the file you want to copy by 

clicking it once. 
 
2. Use the mouse pointer to click the File menu heading, 

and then choose Duplicate.  Notice how a second icon 
with the same name (plus the word ‘copy’) appears 
beside the original icon. Move the copy to the desired 
location. 

You may want to change the name of the duplicate 
file/folder to remove the word ‘copy.’  (See the section How 
Do I Change the Name of a File or Folder?) 
 
How Do I Copy a File From One Floppy Disk to 
Another on a Macintosh With Only One Floppy 
Disk Drive? 
 
1. Insert the original disk (that contains the file to be 

copied) into the floppy disk drive. 
 
2. Make a copy of the file as described above and move 

the copy onto the hard drive. 
 
3. Eject the initial disk (by dragging the disk icon into the 

Trash) and insert the second disk. 
 
4. Move the copy file from the hard drive onto the new 

floppy disk. 
 
How Do I Delete Files? 
 
To delete a file or folder, select the corresponding icon with 
the mouse, hold the mouse button down and drag the 
selected icon towards the Trash.  When the Trash icon is 
highlighted, let the button go, and the file is deleted. 
 
DO NOT delete files unless you are absolutely sure you 
want them to be removed. If you accidentally place a file in 
the Trash, immediately double-click the Trash icon and 
remove the item from the Trash window.  If you wait too 
long before doing this, the item you accidentally trashed 
may be deleted for good. 
 

 
 

How Do I Change the Name of a File or Folder? 
 
1. Click the name (NOT the icon) of the file or folder.  A 

white border appears around the file name. The whole 
icon is highlighted. 

 
2. Enter the new file name; it replaces the old name. 
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What are “Pull-down” Menus? 
 
The words running across the top of the screen are “menu” 
headings.  A menu displays several different commands that 
you can activate. These menus appear on the screen under 
the menu headings whenever the headings are selected. 
 

 
 
These are called “pull-down” menus because they are pulled 
down from the top of the screen.  When they are not 
selected, these menus disappear from the screen, leaving 
only their menu heading visible in the top bar. 
 
How Do I Select a Pull-Down Menu? 
 
Move the mouse arrow pointer until it is on top of a menu 
heading. When you push the mouse button, the list of 
options (the menu) drops down.  Move the mouse down (in 
your direction) to move through the various options in the 
menu.  The different commands in a menu are highlighted as 
they are selected. When you have the appropriate command 
darkened, press the mouse button again.  The command 
activates, and the menu disappears. This process is known as 
“choosing” a menu option. 
 
If you reveal a menu, but then decide you do not want to use 
any of the commands, move the mouse pointer out of the 
area of the menu.  If you put the pointer on a different menu 
heading, that menu drops down.  To select nothing, move the 
mouse pointer into the blank space on your desktop and 
click the button.  The displayed menu disappears and no 
command is selected. 
 
If any of the commands in the drop-down menu are light 
gray rather than black, this indicates that the command is not 
available to you at this time.  For example, the Print option 
is only valid when you have selected a document with your 
mouse first. 
 
NOTE:  One way in which OS X differs from previous 
versions of the Macintosh operating system is that you no 
longer need to keep the mouse button pressed to continue to 
see the pull down menus.  Like a Windows mouse, one click 
on a menu heading causes the menu to drop down and 
remain visible until a selection is made. 
 
 
 
 
 

The Macintosh Desktop 
 
The Macintosh “desktop” is the first screen that appears 
when you turn on your Mac.  The display has small pictorial 
symbols on it, that represent which software applications, 
files and disks are available to be used.  An application is a 
computer program that runs to accomplish a specific 
purpose, such as typing a document or creating a chart.  The 
pictorial symbols on the desktop are called “icons.”  The 
words running across the top of the screen are “pull-down” 
menus.  Icons and pull-down menus are activated with the 
mouse.  
 

Changing the StartUp Disk 
 
The operating system that appears when you first turn on 
your Mac can be switched between 9.1 and OS X. If OS X is 
running and you would like to run 9.1: 
 
1. Click the Apple icon in the upper left-hand corner. 
 
2. Choose System Preferences from the menu. 
 
3. Double-click the Startup Disk icon. 
 
4. Choose the System Folder you want to use to start your 

computer. 
 
5. Close the window and restart the computer. 
 

 
 
If OS 9.1 is running and you would like to run OS X: 
 
1. Click the Apple icon in the upper left-hand corner. 
 
2. Select Control Panels. 
 
3. Select Startup Disk. The Startup Disk window 

appears. 
 
4. Click the down arrow next to Macintosh HD. 
 
5. Select Mac OS X. 
 
6. Close the window and restart the computer. 
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Using the Dock 
 
If OS X is running, the Dock, a new feature of Mac OS X, 
appears at the bottom of your screen. It contains icons of 
folders, files, applications, servers and Web browsers.  
 

 
NOTE: The small arrow that appears underneath an icon 
signifies that the program represented by the icon is 
currently open 
 
To access any of these files or applications, click one of the 
icons in the Dock. If a file or application isn’t in the Dock, 
its icon appears there once you open it. 
 
To open a document using one of the applications in the 
Dock, drag the document’s icon to the application’s icon in 
the Dock, and the document opens. 
 

How Do I Start Macintosh Applications without 
using the Dock? 
 
1. When you log onto a Macintosh, the Macintosh hard 

drive icon appears on the desktop. Double-click it. The 
hard drive window is displayed. 

 
2. Click the Applications button. All of the Mac’s 

applications are displayed in the window. 
 

 
 

What Are Windows? 
 
When you double-click an icon, the Macintosh operating 
system displays a window on your screen.  Windows appear 
on the Macintosh desktop and are also used inside 
applications.  If you double-click a server icon, a disk icon, 
or a folder icon, a window displays all of the files available 
in that area or on that disk. 
 
Once a window is opened, you can use the mouse to open 
any files or folders or use any applications that appear in the 
window.  
 

 

Many different windows can be opened at one time and are 
visible on the Macintosh desktop.  Windows can be 
compared to a group of papers piled on a desk.  Although 
many papers may be visible, only one is on top.  The 
Macintosh window that is on top of the others is the only 
window that you can use - it is the only active window.  The 
other windows are slightly grayed out. 
 
NOTE: If you point and click any area of an inactive 
window, that window moves to the top. 
 
Adjusting Windows 
 
Windows may have to be adjusted in order to see all of the 
icons that they contain.  Most top windows feature scroll 
bars that run along the right and bottom edge. 
 

 
 
Point and click the arrows in the scroll bars to move the 
visible portion of the window so you can see any icons that 
are not initially visible.  If all of a window’s icons are visible 
on the screen, then the scroll bars do not appear. 
 
The top window also has a size box in the lower right corner. 
Position the mouse pointer on this box and hold down the 
mouse button. Now you can drag the mouse to adjust the 
window’s size. 
 
Closing Windows 
 
To close a window, position the mouse pointer over the 
small, red circle in the upper-left corner of the window and 
click the mouse button.  The small box is known as a Close 
box. 
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Connecting to a Server Using 
Macintosh OSX 

 
1. Click anywhere on the desktop to activate Finder. 

 
2. Select the Go menu and choose Connect To Server. 

The Connect to Server window appears. 
 

 
 
3. Click the down arrow at the far right of the At: field and 

the window expands. 
 

4. Enter the server’s IP address in the Address: field or 
click Local Network and choose which host to log 
onto. 

 

 
 
5. Click Connect. You are prompted to login. 
 

 

6. Depending on the configuration of the server you are 
trying to connect to, you must:   

  
a. Select Registered User and insert your 

username in the Name field and password in 
the Password. Click Connect. OR  

b. Select Guest and click Connect. 
 
7. After you connect, a window appears showing all 

accessible drives and/or folders. 
 

 
 
8. Choose a drive and/or folder, and click OK. 
 
NOTE: If there are multiple drives/folders, and you wish to 
choose more than one, hold down the Shift key as you make 
your selections with the mouse. 
 
After clicking OK, an icon representing the server you are 
accessing appears on your desktop. You are now connected. 
 

 
 
9. To dismount the server, drag the icon into the Trash. 
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How Do I Use a Zip Disk to Store My 
Work? 
 
You should have at least one zip disk to store your work.  
Disks are available for sale at any office supply or computer 
store. 
 
NOTE: Most new Macintosh computers do not come with a 
floppy disk drive. If you need a floppy drive, the Imation 
SuperDisk Drive is available. This will allow you to retrieve 
and store work on a floppy disk. 
 
Most disks are high density (HD).  High-density disks store 
more work, but they may not operate in very old 
Macintoshes outside of the Pitt campus.  (All campus 
computing lab machines can use HD disks.) 
 
Insert your zip disk into the drive. If the disk is PC 
formatted, you are asked if you want to initialize it. Click 
Format to format it for a Mac.  
 

The Save Command 
 
Since saving your work is very important, all Macintosh 
applications have a Save command available, usually under 
the File menu heading.  
 

 
 
The first time that you select Save, a dialog box appears. 
This is where you specify a new file name, the file type and 
storage location.  By default, the File name: field is 
highlighted and contains a blinking line called an I-beam. 
 

 
 
1. Enter the name of your file in the box. 
 
2. Click on Desktop until you see the name of your disk 

displayed in the window.  Double-click the line that 
displays the disk icon and the name of your disk.  Your 
disk should then be listed on the top line of the dialog 
box. 

3. Click Save. 
 
You should save your work to a disk about every 15 minutes 
or so to ensure that your work is permanently stored, in the 
event of a power failure or computer glitch.  CSSD 
recommends that you store your work (especially large or 
important files) onto two separate disks in case one of the 
disks should get lost or damaged. 
 
 

Setting Up a Printer 
 
Because OS X uses a TCP/IP protocol for almost all 
networking, AppleTalk is not being used to set up printers.  
Therefore, the Chooser printer setup is no longer used.   
 
Another change is that an icon no longer appears on the 
Desktop once a printer is set up. 
 
1. Open the Utilities folder located within the 

Applications folder on the Hard Drive.         
 
2. Double-click the Print Center icon. The Printer List 

window appears. 
 

 
 
3. Click Add Printer, and another window appears within 

the Printer List window. 
 
4. Click the double arrows in the new window and select 

one of the choices from the drop-down box. The choices 
include AppleTalk, LPR Printers using IP, USB and 
Directory Services. These represent the different types 
of printer connections you can use.  Directory Services 
is the default. 
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• To use AppleTalk, select AppleTalk from the drop-
down list.  An AppleTalk zone appears below the 
AppleTalk drop-down box.  You can change the zone 
by click the double arrows and selecting a new one from 
the list. 

a. Select one of the printers from the list of 
recognized AppleTalk printers. 

b. Click Add. 
 

 
 
• To add an LPR Printer, select LPR Printers using IP 

from the drop-down list.  
a. Enter the appropriate IP address in the LPR 

Printer’s Address: field. 
b. Click Add. 

 

 
 
• To add a USB printer, select USB from the drop-down 

list.   
a. Choose one of the printers listed. 
b. Click Add. 

 

 

Once you have finished setting up all of your printers, the 
Printer List screen appears. It includes the names all of the 
printers you have added.  The printer with a blue circle next 
to its name is the default printer.  You can change the default 
setting by double-clicking the printer you want as your 
default printer. 
 
 

Printing 
 
In order to get a printed copy of your work, you must issue a 
print command.  Like the Save command, Print is generally 
located under the File menu.  Printing procedures differ 
slightly depending on the application that you are using. 
 
You can select the printer from the Print dialog box that 
results when you select Print from the File menu within an 
application.  Select the printer you want from the drop-down 
list that appears when you click on the downward arrow 
beside the Printer: field. 
 

 
 
To change the default settings, select the arrow box next to 
Copies & Pages. For example, if you want to print double-
sided: 
 
1. Select Copies & Pages and choose Layout. 
 
2. Click the arrow box next to Pages per sheet and choose 

2. 
 
 

Quitting Applications 
 
1. Choose Quit from under the open application’s menu. 

For example, to close TextEdit, select Quit TextEdit 
from the TextEdit menu. You can also press the 
Command button and Q. 
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Many applications give you one more opportunity to save 
your work before quitting. A dialog box appears asking if 
you want to save your work one more time before the 
program quits. 
 
NOTE: If you have not saved during your session and do 
not save at this time, all work done during your session is 
lost when the application quits. 
 
2. Click OK if you have done any work since your last 

save, or click Don’t Save to bypass this step. Unless 
you are positive that you do not want to save any 
changes or that you have not made any changes since 
your last save, it is best to save when prompted - just to 
be on the safe side. 

 
 

Logging Out of Your Macintosh 
 
Eject your disk before you log off of the machine. Do this by 
selecting the icon for your disk and dragging it to the Trash.  
When the Trash icon is darkened, release the button and 
your disk is ejected. (This will NOT erase anything on the 
disk.) 
 
1. Select Log Out from the Apple menu. 
 
2. The computer logs out of the system and then brings up 

the logon screen to be completed by the next user of the 
machine. 

 
NOTE:  Be sure that you always log off of your Macintosh 
when you are finished using it.  If you leave a Macintosh 
without logging off, the next user can access your University 
Computer Account, and can use your printing allocation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Getting Help 
  
There are a number of sources of help for using a Macintosh.   
 
Click the Help menu heading and select Mac Help.  The 
Mac Help dialog box appears.  You can: 
 

• Enter a question in the white box and click Ask. 
• Choose an option under Quick Clicks. 
• Get the latest news. 
• Go to the Mac OS X Web site. 

 
If you cannot find the answer by using Mac Help, CSSD has 
produced a series of Getting Started help sheets for various 
Macintosh applications.  See the documentation racks or a 
Lab Consultant in the nearest campus computing lab for 
available titles.  Help sheets are also available for download 
at http://technology.pitt.edu. 
 
For additional information, please contact the Technology 
Help Desk at (412) 624-HELP [4357] or via the Web at 
http://technology.pitt.edu. 


